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No matter what religion you practice or believe in –
or even if you aren’t a religious person at all – it’s
easy to get swept up during the holiday season with
the holiday spirit. Unlike at any other time of the
year, people seem to be more tolerant, a little bit
kinder, more generous, and a better human being
overall. Most people act the way you wish they
would throughout the rest of the year.

It’s also easy to understand why so many people
view the holidays with disdain. Large, pushy crowds
fill the stores, self­
absorbed in their quest
for that perfect gift. The
stores open earlier and
stay open longer in a
greedy grab for more
and more profits. It’s
next to impossible to
even find a parking
space at your favorite
store, even if you’re
only joining the throngs
to buy essential items.
The commercialism of
the holidays has
masked or stripped
away the true meaning
of the holiday season
for some people.

This year, my wife and I
have a new reason to
look forward to the
holiday season. For the
first time, we get to play
Santa Claus, since the
arrival of Ryan. We
recently went to Toys R

Us (with Ryan in tow, who slept throughout most of
the shopping trip – as long as he was moving in the
shopping cart) to purchase the Santa gifts for him.
We’ve looked forward to being able to do this for
such a long time, and we weren’t sure we’d ever get
the chance.

Many people will testify that children change your
life. Indeed, having children makes you rearrange
the priorities in your life. It gives you a different world
view. It makes you more closely examine and spend

more time thinking out
the consequences of
your actions. It gives
you a new appreciation
for things you might
have previously taken
for granted. Yes,
having children does
change your life, for
the better.

I can only hope that we
can all hang on to that
“holiday spirit” well into
the new year. I hope
that we can all keep
our priorities straight
and in better order. I
hope that we can all
bear witness to the
innocence of a child,
and marvel in it.

Until next month, I bid
each and every one of
you peace, happiness,
serenity and prosperity.
Happy Holidays!
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by Meemaw

In this last installment of LibreOffice Tips & Tricks, I
will include just a few things that weren’t in earlier
articles.

Import PDFs

You can open a PDF in LibreOffice, but it will open in
LODraw. Sometimes, depending on the complexity
of the PDF, may not open correctly. However, if you
have a PDF that was created by someone else, and
you feel the need to open it to correct a grammar or
spelling error, you can do it in LibreOffice Draw.
Notice that when you click on the error you want to
correct, LODraw treats every line as a separate text
frame.

Extensions

LO Extensions are separate items that enhance the
program. These include clipart collections, extra
dictionaries and many more. I have one called
“Export As Images,” which will export each page of a
presentation as a jpg, png, gif, bmp or tiff image.

You should go to the site and browse to find

something that you can use. I have found a calendar
extension, a barcode extension, and many different
language dictionaries and spell­checkers.

The calendar extension allows you to open a
calendar from within LibreOffice by clicking Tools >
Add­ons > Calendar, or pressing <CTRL> +
<Shift> + F2. Highlighting a cell and double­clicking
a date with insert that date into the selected cell.

Templates

LibreOffice has a number of templates included by
default, but you can download templates from the
LibreOffice site. If you go to the main LibreOffice
site, you should click on “Features” to find a link to
Templates. From there, you are directed to the
separate template center, where you can choose
from available templates to download. The direct link
is http://templates.libreoffice.org/. You should see
budget worksheets, fax covers, presentation
backgrounds and many more.

Another site, Vertex42, has a huge number of
document and spreadsheet templates you can
download. Even though the site advertises “Excel
Templates”, most of them are in OpenOffice format
as well as MS Office format. There are invoices for
calendars, timesheets, invoices, financial tables and
many more.

Now, imagine you have designed a form,
spreadsheet or even just a letterhead that you use
all the time. It might be nice to save it as a template.
I have an accounts payable spreadsheet that I share
with my board. Another secretary friend of mine
asked what I used, so I saved it as a template (with
all my company information removed) and sent her
the template.

Simply design your spreadsheet or document with
the basic design. Make sure any automatic
calculations are included. In mine, there are two
locations that have sums to be calculated.
When you are satisfied, click File > Save As
Template.. or click <Shift> + F11. The templates
window will open, allowing you to designate the
location where you want it saved. When you click on
the location, you will be asked to name your
template. Give it a meaningful title and click OK.
Now, when you click on Open Templates, it will be
there.

Dock & Undock Toolbars

I like my all toolbars embedded in the program
window. Some people like theirs separate from their
work window. While you probably have your
workspace set up just the way you like it, I’ll give you
a couple of shortcuts to change it just in case you
ever want to do so. One way, of course, is to grab
the toolbar using the “handle” and move it wherever
you want it. The other way is to position your mouse
over the handle and, holding down the <CTRL> key,
double­click on the toolbar handle. The toolbar
should pop right out of the docked position into your
workspace where you can grab the title bar (just like
any other window) and move it where you want it.
Repeating the same procedure (<CTRL> + Double­
Click) on the title bar of the undocked toolbar should

LibreOffice Tips & Tricks: Extras
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pop it right back into the place it was before you
moved it.

Macros

A macro is a recording of keystrokes and mouse
actions. Macros are designed to save you time.
Rather than having to repeat the same task
repeatedly, you only have to do it once and the
macro will then repeat it for you. Suppose I have
several spreadsheets for a presentation and want
the titles formatted the same on every spreadsheet,
so it looks uniform. I don’t want to do the same
formatting over and over. So, I’m going to do a
macro for that formatting. That way I can be sure the
titles are formatted the same every time. I put in the
title of one spreadsheet and merged several cells
before I started my recording.

1. Make sure macro recording is enabled in your
copy of LibreOffice. Go to Tools > Options >
LibreOffice > Advanced and enable it by checking
the box that says “Enable macro recording”.

2. Open up a blank document or the document you
need to format.

3. Click on Tools > Macros > Record new macro. A
small box will pop up telling you that recording is on,
with an area to click when you want to “Stop
recording”.

4. Proceed with your recording. I will record the
following formatting: Font ­ A & S Speedway, Size ­
24, Color ­ Black, Background ­ Blue11. That’s all I
want to do, so I will click the stop button.

5. As soon as you stop the script, you are presented
with a window that shows the organization of the
macros, and asked what name you want to give your
macro. I chose “TitleFormat” and saved it in My
Macros > Standard. You need to choose something
that describes your macro’s function so you can find
it again. If it is more than one word, be sure to save
it with no spaces between the words. Click Save.

6. Play back the macro. With another title filled in, go
to Tools > Macros > Run macro and choose
TitleFormat from the choices.

Notice that your document name is listed in the
organizational structure. You can store your macro in
only one document if you wish. For a spreadsheet
that uses a certain calculation, the macro can be
specific to that document by being saved there.

I will admit that I don’t use macros too much, and
never have recorded one until this one. However, it
worked really well! I hope that this can give you an
idea of how to record a macro. In all the articles I
read, the author urges you to have the steps you are
going to record firmly in your mind, or jot them down
somewhere before you start your recording.

I hope that you have picked up a few pointers in this
series. I know I have. Knowing more about
LibreOffice is sure to make you better at using it.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

LibreOffice Tips & Tricks: Extras

mailto:pclinuxos.mag@gmail.com
http://www.tuxmachines.org


PCLinuxOS Magazine Page 6

by Paul Arnote (parnote)

Imagine that you just returned from vacation or
holiday. You shot lots of photos. You would like to
share those photos with friends and family, and
possibly even post them to your favorite photo
sharing site. But, before posting your photos to the
photo sharing site, you might want to add a
copyright watermark to your photos. It will allow
everyone to know who the photo belongs to, who
shot it, and may help prevent less capable users
from stealing your work. The copyright statement is
also appended to the Exif data of JPG files.

For months, I’ve been reading (and re­reading) a
column on the Linux and Life blog that shows how to
add a transparent watermark to photos. The only
problem was that it required a fair amount of manual
manipulation, and it only worked on one photo at a
time. As a result, it wasn’t very efficient if you have a
lot of photos that you want to apply a watermark to. I
thought there ought to be a way to automate the
entire process, so I created a bash script to do
exactly that.

The script requires that you have ImageMagick,
jhead and Zenity installed on your system. You will
need to install them from Synaptic, if you don’t
already have them installed.

Before we go any further, let’s take a look at the
script. It ended up not being very long or involved.
You can type in the script, copy and paste it, or
download it from The PCLinuxOS Magazine website.
If you choose to download the script, be sure to strip
the “txt” file extension from the file name, and mark
the file as executable. You will want to place the
script in a directory that is in your path statement.

1. #!/bin/bash
2. 3. # Copyright © 2013, Paul Arnote. All Rights Reserved.
4. # As originally published in The PCLinuxOS Magazine, November 2013.
5. # Released under the GPLv2 license.
6. #
7. # You are free to alter, change or distribute this work, provided
8. # you do so while retaining this notice, and so long as your derivative
9. # work is also released to the public under any of the GPL licenses. Any
10. # distribution of this work must also comply with the terms of the GPLv2
11. # license, and no charge may be made for this work, whatsoever.
12.
13. Year=`zenity ­­title="Watermark" ­­entry ­­text="Enter the image year (e.g. 2013):"`
14. if [ $? == 1 ]; then
15. exit
16. fi
17.
18. Photog=`zenity ­­title="Watermark" ­­entry ­­text="Enter photographer name:"`
19. if [ $? == 1 ]; then
20. exit
21. fi
22.
23. Text="Copyright © ${Year}, ${Photog}. All Rights Reserved."
24.
25. compass=$(zenity ­­list ­­radiolist ­­column="Select" ­­column="Action" ­­
title="Watermark" ­­width=200 ­­height=350 ­­text="Select the position of your\nwatermark
text:" TRUE SouthEast FALSE NorthWest FALSE North FALSE NorthEast FALSE West FALSE Center
FALSE East FALSE SouthWest FALSE South)
26. if [ $? == 1 ]; then
27. exit
28. fi
29.
30. n=1
31.
32. for file in $@; do
33. width1=`identify ­format %w $file`
34. height1=`identify ­format %h $file`
35. EXT=$(echo "${file##*.}")
36. name=$( echo $file | cut ­f1 ­d.)
37. outname=${name}"­wm."$EXT
38. convert ­size "$width1"x"$height1" xc:transparent ­gravity $compass ­font
/usr/share/fonts/TTF/liberation/LiberationSerif­BoldItalic.ttf ­pointsize 25 ­fill Yellow
­draw "text 0,0 '$Text'" ~/tmp/overlay.png
39. composite ­dissolve 50% ­quality 100 ~/tmp/overlay.png $file $outname
40. if [ $EXT == 'jpg' ] || [ $EXT == 'JPG' ] || [ $EXT == 'jpeg' ] || [ $EXT ==
'JPEG' ]; then
41. jhead ­cl "${Text}" $outname Continued on next page

Watermark Your Photos With Ease
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If you are typing the script in a text editor, or if you
are copy and pasting it, be sure to delete the line
numbers that I placed below to help you follow along
in the script. Commands that span multiple lines are
intended to be typed/entered on one long,
contiguous line in the plain text editor.

Running The Script

Running the script, which I’ve named watermark.sh,
is actually quite easy. Open a terminal session and
enter the following at the command line:

watermark.sh
/path/to/your/image/folder/*.jpg

The script will work with any graphic file format that
ImageMagick recognizes (which is just about any
graphic format you can throw at it). I only used *.jpg
files as an example, since that is the format that
most digital cameras use to save their images.

Using the defaults of the script, you will first be
prompted for the year of the image.

You will next be prompted to enter the name of the
photographer. This information is used to “assemble”
a proper copyright statement to display as your
watermark.

Next, you will need to specify where you want your
watermark to be placed. The script uses the
ImageMagick ­gravity command line parameter,
which itself takes on a compass point style of
parameter to help determine the placement of the
watermark text. The following graphic will give you
an idea of where your watermark text will be placed,
with all nine possibilities listed:

“SouthEast” is the default value, placing the
watermark text in the lower right corner of the
photos.

Once you’ve determined where on your photo you
want to place your watermark, select the OK button.
A Zenity progress bar dialog box will be displayed to
keep you informed of the progress through the job.
Also, each image is renamed with “­wm” appended
to the original filename, to differentiate it from the
original, to identify the image as possessing a
watermark, and – most importantly – to prevent your
original photo from being overwritten.

42. fi
43. echo $(($n * 100 / $#))
44. echo "# Processing file: $name­wm.$EXT"
45. let "n = n+1"
46. done | (zenity ­­progress ­­title "Adding Watermark To Image..." ­­percentage=0 ­­
auto­close ­­auto­kill)
47. 48. rm ­f ~/tmp/overlay.png
49. exit 0

Watermark Your Photos With Ease
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What You Get

The top image is the original image. The second
image is after application of the watermark. For the
watermark, I used 2006 as the year that the photo
was shot, along with my name. The watermark is
created and applied to the image, in yellow text
using the Liberation Serif Bold Italic font, in 25 point
size, at the bottom right corner of the image.

How It Works

As the script “walks” through a whole directory full of
images, the copyright statement is constructed from
the information entered in the first two Zenity dialog
boxes. Then, as each image is processed, the width
and height of each image is read into variables. A
PNG file with a transparent background is created,
and the text written in yellow, 25 point Liberation
Serif Bold Italic text, at the location specified by the
ImageMagick gravity parameter that you specified.
That transparent PNG file is then laid over the
original image, and a new image is created from the
two, creating the transparent text. The script also
checks to see if the output file is a JPG file, and if it
is, appends the text information (our copyright
statement) to the end of the JPG Exif data. After all
the images have been processed, the temporary
transparent PNG file (stored in your ~/tmp folder as
overlay.png) is deleted just before script exits.

Customizing The Script

What if you don’t really want a copyright statement
watermarked on your photos? What if, instead, you
want your email address and/or your website
address to serve as the watermark? In that case (or
any other case where you want different text
displayed other than the default copyright
statement), alter line 23 of the script with the text
you do want displayed. If you don’t want or need the
dialog boxes to prompt you for input, you can
comment them out, simply by prepending “# “ to the
beginning of each line you want to prevent from
being executed.

What if you want to use a different color for the
watermark text? That one’s easy enough. The
default color is yellow (which happens to be my
favorite color). You can choose any color that
ImageMagick recognizes in line 38 of the script.
Right after the ­fill parameter, replace Yellow with
whatever other color you want to use. You can find a
complete list of colors that ImageMagick recognizes

here. You can use the color name, the RGB values,
or the hex values. Most users will find it simplest to
use the color name. It’s best to avoid using colors
that are too light, too bright, or too dark. I
recommend trying a new color choice on a few
different photos to be sure it works well and is visible
on a variety of backgrounds.

What if you want to use a different font for your
watermark text? Simply change the path and
filename in line 38 of the script to reflect the filename
of the font you want to use. Liberation Serif Bold
Italic is the default, and is located in
/usr/share/fonts/TTF/liberation/ directory. While
you’re at it, you can also change the size of the text
by changing the ­pointsize 25 entry on line 38 to
whatever font point size you want. I would caution
you to not make it too small, however. It would be an
equally bad idea to make it too large, since the
watermark text may detract from your photo(s) if it’s
too large.

“Advanced” Uses

Having just completed the Xfce Power User Tips,
Tricks & Tweaks article series, this script is yet
another tool that can easily be turned into a Thunar
Custom Action. Simply set the command as
watermark.sh %F or watermark.sh %N. You can
name it whatever you like, but I would recommend
“Watermark Images” as the name. Under the
“Appearance Conditions” tab, set the file pattern to *,
and place a checkmark in front of Image Files.

You can also create a custom KDE context service
menu. Ensuring that the script is stored in a directory
in your path, you can create a custom KDE Service
Menu entry that’s available in Dolphin’s or
Konqueror’s right click context menu. You can refer
to the article in the October 2012 issue of The
PCLinuxOS Magazine for more information about
creating a new KDE Service Menu. Below is my
suggestion for the .desktop file that creates the KDE
Service Menu for using the watermark.sh script.

Watermark Your Photos With Ease
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[Desktop Entry]
Type=Service
Name=Watermark
Encoding=UTF­8
ServiceTypes=KonqPopupMenu/Plugin,image/*
Actions=Watermark;
MimeType=mif;PNM;pgm;ppm;bmp;ras;JP2;JPC;jp
g;jpeg;png
Icon=image­x­applix­graphics
X­KDE­Submenu=Watermark

[Desktop Action Watermark]
Name=Apply Watermark To Selected Photos
Exec=watermark.sh %F
Icon=image­x­applix­graphics

Be sure to run the command kde4­config ­­path
services at a command line prompt in Konsole to
find out where to store the .desktop file for your new
KDE Service Menu. If you want your new service
menu to only be available to you, choose to store
your .desktop file in the location indicated in your
/home directory. If you want your new service menu
to be available to every user on your computer,
choose to store your .desktop file in the location
indicated in your /usr directory. Remember that the
latter can only be written/placed there with root user
privileges.

Summary

Now, with the watermark.sh script, it’s easier than
ever before to watermark your photos. It may take a
little bit of time to do a large number of images, but
you can start the process and simply allow it to run
in the background while you perform other tasks.
Furthermore, thanks to the script renaming the
output file, you can rest assured that your precious
original photos are not overwritten. Still, it’s always a
good and prudent practice to only EVER make edits
to copies of your images, with the originals safely
stored elsewhere.

Screenshot ShowcaseScreenshot Showcase

The place where breaking news,
BitTorrent and copyright collide

Posted by OnlyHuman, November 24, 2013, running e17.

Watermark Your Photos With Ease
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by loudog

There are many video editing software choices on
the market today, from simple free home movie
makers to fully developed professional editors
costing hundreds of dollars. Having used the simple
ones and paying dearly for a professional version in
the past, I have concluded that Kdenlive is in a class
of it’s own. It has improved dramatically in the four
years since I discovered it. The program provides a
video editor that’s fairly easy to use, all the
professional tools necessary for eye­pleasing
polished videos, and plenty of effects. Want to fly?

Dance with the stars? Kdenlive provides the tools to
do just that … in the movies, of course. To top this
off, it’s open source and absolutely free. Like most
open source projects, donations are gladly
accepted.

In this first article we will be making a simple video
from some short video clips we shot with our
camera, phone, tablet etc. So first things first, let’s
start the program and get acquainted with the GUI.
As you can see, it’s pretty barren looking and not
very intuitive. That’s OK, because we all crawled
before we could walk. So let’s crawl up to the “new”
icon in the upper left corner and select that. Tip:

Kdenlive has the undo and redo options. The menu
that we are presented with is the project’s initial
parameters.

Select the video quality your videos are formatted in
from the menu. If you don’t know, Kdenlive will
select it for you when the first clip is played. I will be

KDenLive: Part One
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using the example in the image (HD 720p 29.97
fps), as this is the set format for my video camera.
Notice also that you have audio/video track options.
You can add or subtract the amount of tracks you
want.

We will leave this on the default settings, as that will
serve our needs for this particular project. Click ok.
Next, we want to select our monitors. To do that, we
will go up to the top and click the view tab. From the
menu, select clip monitor, project monitor and then
project tree. You will see the project tree window on
the left, the video monitor in the middle and the
timeline window at the bottom. Your version may
have them already checked and open by default.

I like to increase the size of my video monitor. You
may do what is most comfortable for you. To do this,
grab the top of the timeline window and shrink it
down until the video monitor almost touches the
project tree window.

Then, drag the bottom of the project tree window
down until it fits properly.

Now we are ready to add some video clips to the
project tree. In the project tree window, click the little
blue arrow in the upper right corner, and select the
add clip option from the menu.

KDenLive: Part One
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This will open a window that allows you to navigate
to your video files. I will be using the “chocolate
cream stout” folder, which contains a number of clips
that will be used to assemble a video tutorial on the
brewing of a chocolate cream stout beer. You can
open your folder with the files you want to use and
select/open them individually or, as in my case, I
know all the clips in the folder will be used so I
highlight them all and click open.

It may take a minute or two for them to be imported
into the project tree. And voila, there they are in the
tree with one already queued into the clip monitor.

Now is a good time to save the project (called a
document) with an appropriate name. Unfortunately,
Kdenlive does not auto save your progress, so

occasionally hitting the save icon is a good idea. I
learned this the hard way. However, remember that
once the save button is hit, you cannot undo from
that point on (I learned this the hard way, too). Go
ahead and click the play button to watch the
particular clip in que. Cue a different clip on the
project tree by clicking on it. If you are having a
difficult time choosing the proper clip by name, you
can watch it in the viewer, then right click on it in the
tree and rename it for easier reference.

Before we get started on actually putting the video
together, I have found that an introduction looks
nice. I prefer to use .png files. You can use almost
any picture format you want, but it’s important that
the size is as large or larger than our anticipated
output pixel size. Output size is chosen during the
rendering process at the end. I will choose 720p at
the end, so the standard for that format is 1080x720
pixels. An image size of 1024 x 768 will work alright,
but if you can enlarge it slightly, then crop it into a
16:9 aspect ratio (1080x720), it would be better, as
there will be no noticeable squishing and/or
stretching of the image in the final render. Gimp is
an exceptional image manipulating program that can
do this, but for a quick, no nonsense resize and/or
crop edit, Gwenview is my personal choice. Go to
the project tree, add clip button and add your image.
If you don’t have one, you can skip this part. I have
selected a recent wallpaper I created in Gimp, since
it was handy, and I still enjoy its straightforward
lighthearted message.

Place your mouse on the image file in the project
tree and drag and drop the file into the first video
track. This lower area is called the timeline.

Make sure you have it moved all the way to the
beginning of the track, you will see the snap to
timeline movement when it is set. You may have
noticed that when you placed the file there, the
monitor tab changed to project view (the tabs below
the project tree window). Go ahead and play the
image, I believe the default is 5 seconds. Rewind the
player. You will also notice a long line that hangs
down from an arrow, that moves across the timeline
while the video plays. This is called the timeline
marker. You can move this marker at any time with
the mouse by dragging the red triangle back and
forth. If you select another clip in the project tree, the
monitor will revert back to clip monitor.

No intro is complete without sound, so we are going
to import an audio file from the open source fair use
library. All of the files in the library are free to use in
your projects, Kdenlive or otherwise. It just so
happens Kdenlive has the library embedded into the

KDenLive: Part One
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program. (Just gotta love open source!) At the top of
the window, click the project tab, then the online
resources option.

This will open a window that lets you choose from
three different main categories, then you can do a
search for a particular style/genre. When your

search results are displayed you can choose a file
and preview it before downloading it to the project. I
have done a search for heavy metal, and, after
previewing a few, settled on a rather shrieking guitar
grunge.

When the sound clip is imported, it is automatically
loaded into the project tree. Now drag and drop this
sound file into the first audio track timeline, (fourth
track down), making sure its at the beginning of the
track. Go ahead and play this in the monitor.

Now let’s add some effects so as to polish it up a
little. Place your mouse at either the beginning
bottom corner or the end bottom corner of the little
video intro clip in the timeline. You will see a small
green triangle blinking. Right click this and from the
menu select add effect, fade, fade from black if at
the beginning or fade to black if at the end.

The image shows my selecting the tail end of the
clip, so fade to black is the proper choice. You will
now see some new things on the clip, such as a
yellow bar hanging down on the ends, and a triangle
in the upper corners after the effects are added. Now
do the same thing with the sound clip, except
choose fade in for the beginning and fade out for the
end. Play the intro. Not too bad, eh? If you are
satisfied with the intro, a quick save would be in
order at this point.

Next we will add the first video clip from the project
tree. Drag and drop your clip into the second video
track on the timeline. Align the beginning of this clip
with the end of the intro clip, looking for the telltale
snap to timeline movement. Staggering the clips
between two video tracks makes them easier to
work with when you have more editing work to do on
them.

KDenLive: Part One
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As you can see in the image, I am dragging the clip
over to match up with the end of the intro clip. You
may have also noticed this clip is much longer in the
timeline than the intro. Add your standard fade from
black and fade to black effects to the ends of the
clip. For the next clip, just drag and drop it on the
first video track timeline.

Align the clips and add the effects. Continue the
same way, alternating the clips from video track one
and video track two, adding your effects as you go.
When the tracks move out of the viewable timeline,
and they often do, go to the bottom of the screen
and adjust the magnifier. Play with this a little and
you will understand; it will show individual images
from the video on a frame by frame basis. This is
how professionals get the cuts perfect.

I prefer to add an exit to the end also. Tip: Since I
have some experience with this I have the intro clip
we created at the beginning in a separate video file
already rendered and ready to use. I just add it to
the beginning and end of the current project I am
working on without having to do all the effects, etc;
again.

Now that you have all the clips you want in the
project, and the tracks are ready for rendering to a
single file, let’s get Kdenlive ready to utilize your
hardware potential. Rendering video is very
processor intensive and very, very time consuming,
so we want to do a couple of changes from the
default setup. Click on the settings tab at the top of
the window. From the menu, choose Configure
Kdenlive > Environment.

In the processing threads option, choose two for a
dual core, and three for a quad core or more. If you
are doing this on a single core processor leave it at
the default setting. This is still in the experimental
stage, so be aware. I have had no issues with it set
at 3 for my quad core and getting a 35% reduction in
rendering time completion. Close out the window
and select the render button at the top.

This will open the rendering options. Name your file
in the output box. Otherwise, it will show as untitled
in the destination folder. You will see that I made this
mistake (again) in the rendering progress image.
Choose the output format you want. I will choose
MPEG4 because almost any digital device around
will play it. Choose the amount of threads you want

KDenLive: Part One



PCLinuxOS Magazine Page 15

to use. I have had no problems with one thread per
processor, but your hardware may support more.

Audio and video bitrates are fine at default, although
if you imported higher quality clips, let the settings
reflect that. Now a word about two pass encoding. If
you plan on showing your completed video on a
large 1080p flat screen and chose to render it to
1080p, the two pass encoding is the best choice.
Two pass encoding takes twice as long, but is
stunning in detail. If you are going to watch them on
your computer monitor, single pass is fine.
Regardless, I always use 2 pass because the
improved file quality is worth the wait. Select render
to file, grab a refreshing beverage, and wait.

Congratulations friends! You can now go through all
those video clips you have and compile them into full
videos. I believe it’s time to head to the cellar and
enjoy a homemade beverage of my own.

Next month, we’ll take a look at the second article
about Kdenlive. Part two will be about working with
single clips and more movie magic with effects and
transitions.

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

KDenLive: Part One

http://www.cafepress.com/pclinuxos
http://pclinuxos.com/?page_id=188
http://pclosmag.com/html/sorted.html
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Ingredients:

5 bamboo skewers (6 inch)
3 large boneless skinless chicken breasts

(about 1 lb)
4 large green onions
5 strips of cooked bacon cut into thirds (15 pieces)
1/2 cup of your favorite barbecue sauce

Cooking Instructions:

1. Soak skewers in water at least 30
minutes to prevent burning. Meanwhile, cut
each chicken breast in half lengthwise, then
cut crosswise to make 10 (about 1­inch)
pieces. Cut onions into 2­inch pieces (30
pieces total).

2. Heat gas or charcoal grill. Push 1 skewer
through end of 1 bacon piece, then through
middle of 1 chicken piece and back through
other end of bacon piece; add 2 onion
pieces, then repeat with another bacon
piece and chicken piece. Place on large
plate or tray. Repeat to make remaining
kabobs.

3. Place kabobs on grill over medium heat. Cover
grill; cook 5 minutes. Turn kabobs; brush with half of
the barbecue sauce. Cover; cook 5 minutes. Turn
kabobs; brush with remaining sauce. Cover; cook
about 1 minute longer or until chicken is no longer
pink in center. If desired, serve with additional
barbecue sauce for dipping.

Grilled Barbecued Bacon­Chicken Skewers

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

PCLinuxOS Recipe Corner
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by Paul Arnote (parnote)

It’s that time of year again. It’s time for our annual
holiday gift buying guide. If you’re strapped for ideas
of what holiday gifts to buy those on your holiday gift
list, maybe we can help. Between myself, Meemaw
and YouCanToo, we’ll present you with a total of 30
gift ideas – 10 each – for your gift buying needs. All
prices are given in U.S. dollars.

AGPtek® 2.4GHz Hi­Fi Wireless Stereo Bluetooth
V2.1 Headset – Newegg.com, $37.99

Cut the cord! Well, at least to your stereo
headphones. These wireless headphones use
Bluetooth technology to send the audio from your
Bluetooth­enabled device (PC, tablet, smartphone,
BluRay player, etc.) directly to your ears – privately.
These wireless headphones employ a rechargeable
lithium ion battery to provide up to 54 hours of
cordless use, up to 1200 hours of standby time, and
recharge in as little as three hours. Like most
Bluetooth devices, these high fidelity stereo
headphones have a range of 10 meters (or about 33
feet). Of course, the stated range is without
obstructions (like walls) between the headphones

and the Bluetooth transceiver. The package includes
an AC charger and USB cord.

Link Depot USB 2.0 Flash Memory Card Reader
(MicroSD/Secure Digital SD) – Walmart.com, $5.03

If you have a tablet or smartphone, chances are high
that it has or uses a MicroSD card. It can sometimes
be a real pain to connect and read or transfer files
from these devices. But what if you could transfer
your files to the MicroSD card, then read those files
on your computer? It sure would make things much
easier!

This adapter does exactly that. The MicroSD card
inserts into the USB plug. Yes, you read that
correctly. A blue LED lights up to indicate that the
reader is plugged in. To extract your MicroSD card,
press the yellow button and your card slides out to

where you can grab it. Works with MicroSD and
MicroSDHC cards.

Bright 10 LED Flexible USB Light Desk Lamp for
Laptop or Desktop – Newegg.com, $9.40

Never work on your computer in the dark again. This
handy handy lamp plugs into an open USB port (or
USB hub) and lights your computer and desk with 10
bright LEDs. Useful for either a laptop or desktop
computer. The lamp has extremely long service life
(up to 20x longer than normal lamps) and bathes the

LinPC.us
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http://www.newegg.com/Product/Product.aspx?Item=9SIA1NV0UB9402
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area with a soft and warm white light. It features an
on/off switch and consumes low power. The USB
cable is over one meter in length, allowing you to
place the lamp in a convenient location.

5m USB Waterproof Endoscope Borescope
Inspection Camera – Amazon.com, $19.99

Here’s a USB camera with a purpose. Waterproof,
you can send this down a drain to help find a clog, or
a missing piece of jewelry. Send this into a small
hole in the wall to help locate studs and wiring. If
you’re working on the family vehicle, this can provide
views in the tightest locations that you normally
wouldn’t be able to see.

Although the specifications call for Windows, this
endoscopic USB camera is reported to be working
flawlessly with Linux, via VLC. Simply plug in the
camera and launch VLC to view the images. This
camera also includes 4 LED lights to provide
illumination in dark quarters.

Native Union Retro POP Phone – Amazon.com,
$19.99

Do you remember the old
style bakelite telephone
handsets? Are you annoyed
by trying to cradle your cell
phone on your shoulder
while you write down a
phone number or address?
With the Native Union Retro
POP Phone, you can use an
old style telephone handset
with your 21st century
smartphone. Featuring a 3.5
mm plug (standard on many
cell phones), it simply plugs
into your cell phone. Then,
you can put your cell phone
safely into a shirt pocket,
backpack, or purse, and use
the two foot coiled cord (that
stretches out to
approximately six feet) to
talk on your cell phone, with
this handset comfortably
cradled on your shoulder.

While you may get some strange stares as you walk
down the street talking on your cell phone, via this
handset, it does eliminate 99% of the cell phone
radiation. This is a good thing, since it seems as
many studies say it’s dangerous as those that say
it’s of no consequence. With this handset, all doubts
are erased. Just don’t set your smartphone down on
a stationary object and walk away with the handset,
or you may send your smartphone crashing to the
floor.

Rosewill RTK­045 45 Piece Premium Computer
Tool Kit – Newegg.com, $19.99

If you do any of your own work on your computers
and the computers of friends and family (and what
Linux user doesn’t?), it pays to have a dedicated
toolkit to use. This toolkit features not only an
antistatic wrist strap, but a ratcheting multi­tip
screwdriver, a collection of hex key wrenches,
needle nose pliers, wire strippers, tweezers, sockets,
and even a collection of common spare parts. They
are all fit into a zippered black case for easy
transportation. All tools are fully demagnetized to
prevent damage to your system, peripherals and
magnetic media.

I Love Bacon Calendar – ThinkGeek.com, $9.99

I’ve never seen such a large collection of bacon
lovers in one place as I’ve seen in the PCLinuxOS
forum. If PCLinuxOS has an “official food,” it would
have to be bacon. The only gift better for the bacon
lover on your list than bacon would be this 12 month
2014 calendar that allows them to celebrate bacon

Feliz
Navid

ad
Merry Christmas Happy KwanzaaHappy

Holidays
داليم ديجم

с Рождеством Христовым
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http://www.newegg.com/Product/Product.aspx?Item=N82E16899261003
http://www.thinkgeek.com/product/11fd/
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every day of the upcoming new year. Each page of
this calendar contains fun trivia facts about bacon,
along with bacon recipes.

Sizzling Bacon Candy – ThinkGeek.com, $4.99 to
$9.99

While we’re on the subject of bacon, here’s another
idea for the bacon lover on your holiday gift list.
Sizzling Bacon Candy are little rocks of candy that
pop and sizzle when placed in your mouth.
Carbonated candy chunks, to be a little more
accurate. They jump and sputter and taste like
smoky bacon ­ only they "sizzle" right in your mouth.
Each Sizzling Bacon Candy single box comes with 2
packets of bacon (therefore the 3 pack comes with
6), so you'll never be without the sizzling joy of
bacon.

Linus Libertine – Linus Bikes, $939 (no direct link
yet)

OK … this is the most expensive item I’ve ever
featured in the magazine’s annual holiday gift guide.
If you’re in the market for a new bike, why not ride a
bike that shares the namesake of the father of
Linux? In a nostalgic, days­gone­by style, but with
the comforts and reliability of modern bicycle
technology, the upcoming 2014 Linus Libertine
bicycle may be the one for you. This new road bike
features a 16­speed drivetrain with an 8­speed rear
derailleur and a front double chainring that’s fitted to
the crank. It also features “old­school” downtube
shifters, fenders, and two accessory attachment lugs
(one on the downtube and the other on the
seatpost).

If you’re thinking that this bike looks like a throwback
to the road bikes of the 60s and 70s, then you’re
getting the right impression. In fact, the targeted
audience for this new bicycle is someone who might
be prone to look for a classic, vintage bicycle to
rebuild. Here’s the company’s story, from the Linus
Bikes website:

Inspired by French bicycle design of the 50s and 60s we
have created a bicycle that preserves the simple elegance
and pure form of that golden era, but has all the benefits
of modern comfort and reliability. LINUS is the utilitarian
city bike… simple and reliable, but with a personality and
style that makes you feel like you’re in an old French
movie… you’re floating a little from the wine you drank at
lunch… maybe instead of going back to the office you’ll
take a nap under a tree, go for a swim in the sea or drop
by your lover’s house…

In most urban cultures bicycles are viewed as legitimate
transportation and not merely recreation, but sadly this
idea never really caught on in the US. We take numerous
little journeys, under 5 miles, as part of our everyday
lives…. to the store, the pub, to work, etc. Besides the
obvious joy of riding a bicycle, these small bicycle trips
reduce carbon emissions, congestion, noise pollution, and
make for a happier, city experience.

That’s LINUS… a simple, affordable, elegant bike for
riding around and doing stuff.

All of the bikes from Linus Bikes can be viewed on
their website. You can also search for a dealer (U.S.
and Canada only, at this time).

DOWNLOAD

Mate Desktop
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PCLinuxOS Color T­Shirt – PCLinuxOS CafePress
Store, $24.99

What better gift for those on your holiday gift list than
a genuine PCLinuxOS colored t­shirt. These t­shirts
are available in 11 different colors (shirt above
shown in royal blue), and in sizes from small to 3X
(add $3 for sizes XL Tall, 2XL, 2XL Tall, 3X and 3X
Tall), so all are guaranteed to find a size that fits. All
shirts are made with ultra­soft 100% pre­shrunk
cotton (except the charcoal color, which is made
from a 50­50 cotton/polyester blend). Now you and
those on your holiday gift list (who receive this shirt)
can help spread the word about PCLinuxOS!

Screenshot ShowcaseScreenshot Showcase

Linux Training
Courses & Classes

Posted by agmg, November 8, 2013, running KDE.
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by Meemaw

Wow! Shopping time again! This year has really
gone fast, and we are once again faced with picking
out the perfect gifts for friends and loved ones.

I’ve been browsing for the past few days, and have
found a few gifts. Some are a little different, but at
least a different gift probably won’t duplicate anyone
else’s. I tried to find things that any of us could use
or enjoy, and most at a price we can handle.

Many of us already have tablets, so a Tablet Stand
with Keyboard and Carrying Case will complete the
set. Amazon has several models in various colors.
Most of the ones I’ve seen are for 7­inch tablets. The
list price there is $32.25 but they are on sale as low
as $7.88.

I spend most of my computer time in my easy chair
with my laptop in my lap. A lap desk would make
things more comfortable. Bits and Pieces has this
one for $29.99, which includes an LED light and a
cup holder. At 14” x 18”, most laptops will fit on it. If
you want to read a book instead, you should have
everything you need!

Some of these user manuals are written in really
small print, as are some books and newspapers. If
your eyesight isn’t what it once was, maybe this
Page Magnifier Light will help. Also at Bits and
Pieces, it is $12.99. It looks like it would help with
reading or just viewing small items, and the light is
an added bonus (right, top).

If you like grilled food, you probably like smoked
food as well. My husband has smoked just about
every kind of meat. This 2.5 cubic foot electric
smoker will do the job for you. Amazon has several
models that range in price from $80 clear up into the
thousands. This particular one costs $165. It is the
size of a small refrigerator and is very easy to use
(right).

2013 Annual Holiday Gift Guide:
Meemaw's Picks
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While we are thinking about food, I found a popcorn
popper! While that’s not unusual, this is a small,
counter­top version of the big popper we’ve seen at
carnivals and such. J C Penney’s has this model for
only $79.99.

We need something else… How about an apple?
Do you eat the peel, or throw it away? It really is the
part with the most nutrients. Just in case you throw it
away, here is a novel idea for getting the peel off: an
apple peeler. This gizmo, from L L Bean, is only
$29.95, and not only peels an apple, but spiral slices
it as well.

Oh, my gosh! It’s amazing how much dust can
accumulate around my desktop computer! I need
something that can get in all the small areas
between my keyboard, monitor and tower as well as
around the printer and scanner (and all the other
junk that seems to have appeared on that desk!)
How about a mini vacuum cleaner?

Depending on your preference, you can choose from
one of these. At $20 each, either of these could help
tame the dust­bunnies!

ZOpid Desktop Vacuum from Amazon

The Henry Desktop Vac from Bits and Pieces

I’ve been looking at the photos of Parnote’s new
son, and he’s adorable. One gift idea, if you know a
new parent or new parent­to­be, is a layette set
including socks, caps, ‘onesies’, t­shirts, a towel,
washrags, and several other items. Also from J C
Penney’s, the set is $50.99, and also comes in pink
and yellow.

This Aquarium Lamp looks fun! I don’t have fish
myself, but I never pass up a chance to stand in
front of an aquarium and look at the fish. This would

be a good idea
for people like me
who love to look
at them, but don’t
want live ones of
their own. This
one simulates an
ocean reef. It is
7.5” x 12.25” so it
won’t take up
much space, and
is only $29.99 at
Bits and Pieces.
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http://www.jcpenney.com/
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http://www.bitsandpieces.com/aquarium-lamp/p/45458/
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I have always liked jigsaw puzzles, and this one is
unique. It is a Hometown Map Puzzle from L L Bean.
When you order it, you give your US street address
and they make the jigsaw puzzle out of the map of
your area. Your address is at the center, and it
covers six miles east and west and four miles north
and south. It is $39.95 and measures 12” x 18”.
They also have an aerial view puzzle, but it’s $10.00
more.

Speaking of puzzles, Bits and Pieces seems to be
the place for Brain Teaser Puzzles. Many of them
are the frustrating wooden or metal objects that
come apart in many pieces, and the object is to take
them apart, often retrieving something from the
inside, and put them back together. I have several of
these puzzles and while they are often very
frustrating, they are also very fun. They range in
price from $5.99 up to $49.99 (at least on this page!)
The site says there are 74 different puzzles (center,
top).

We’re such a time­oriented world! It is nice to have a
clock that advertises and helps support our favorite
distro! This PCLinuxOS Wall Clock is very nice. It’s
one of the many gifts you can find at the Cafe Press
gift site and is just $13.99.

I hope your holidays are wonderful, and that you find
the perfect gift for everyone on your list!

Donate To PCLinuxOS
Community Supported.

No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one­time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!

You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.

Join us on our Google Group mailing list.
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by YouCanToo

The "Everything Tastes Better with Bacon"
Apron for $19.95

Spice up conversations in the kitchen or around the
BBQ with this tasty­looking apron. Ideal for cooking,
baking, grilling. Two generous pockets hold utensils
and more.

31" long & 29" wide
100% heavy cotton twill
Machine washable

Boss Hog's Bacon Flavored Seasoning $6.00

Make everything taste like bacon! Yes, even your
friend's terrible cooking!

Sometimes you just want everything to taste like
bacon: French fries, bread, fruit, tequila... you're not
picky about what it is you want to taste like bacon,
you just want that scrumptious bacony flavor. There
is absolutely nothing wrong with that! It's just a little
hard to find bacon flavored ice cream or even bacon
flavored French fries whenever, where ever. But we
have your fix right here!

Your Coffee will Taste Better in a PCLinuxOS
Mug $14.99

The perfect size for your favorite morning beverage
or late night brew. Large, easy­grip handle. Treat
yourself or give as a gift to someone special.

Measures 3.75" tall, 3" diameter
Dishwasher and microwave safe

Remember, a portion of the proceeds go to help pay
the bills for PCLinuxOS.

2013 Annual Holiday Gift Guide:
YouCanToo's Picks

Connect connections in one
convenient location!

All your
PCLinuxOS

http://pclosmag.com/links.html
http://www.commandlinefu.com
http://www.fsf.org
http://www.cafepress.com/+tastes_better_with_bacon_apron,394425535
http://www.baconfreak.com/boss-hogs-bacon-flavored-seasoning.html
http://www.cafepress.com/mf/37022118/whtshirt_mugs?shop=pclinuxos&productId=421199759
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Sabrent High Power 1000mW WiFi Wireless USB
Range Extender $19.51

Quickly and easily enhance range and signal quality
at longer distances with the Sabrent Wifi Adapter.
Includes a 6 dBi dipole antenna to help you get the
best connection possible.

Wireless Data Rates up to 54 Mbps

Compatible with all standard 802.11n, 802.11g,
802.11b wireless routers and access points

Transmitter Output Power is 1000mW (1 watt)

Transmitter range up to 800 Meters (2624.67 feet) in
open space.

Operating Systems Supported Linux, Apple and
Windows

Roku LT Streaming Player $49.97

600+ channels with movies, TV shows, music,
sports & more. High­definition streaming up to 720p
HD. Works with virtually any TV. Free app for iOS
and Android. Built­in wireless Wi­Fi b/g/n. RCA Video
and Audio outputs with mini HDMI output

Weight: 0.3 ounces
Dimensions: 3.9 x 3.9 x 1 inches
Specification Met certified frustration­free

Restricted Area Linux Fans Only Hobbies Plastic
Sign $11.99

Use outdoors or indoors. Sign is 8.75 x 11.50 inches.

Barnes & Noble Simple Touch Ebook Reader
$79.00

2013 Annual Holiday Gift Guide: YouCanToo's Picks

http://www.linuxquestions.org
http://pclosmag.com
http://www.newegg.com/Product/Product.aspx?Item=9SIA1N80MR1020
http://www.amazon.com/Roku-2450D-LT-Streaming-Player/dp/B008R7EVE4/ref=sr_1_6?ie=UTF8&qid=1384754070&sr=8-6&keywords=roku
http://www.amazon.com/Restricted-Linux-Hobbies-Plastic-White/dp/B0064RZ5W6/ref=sr_1_63?ie=UTF8&qid=1384758341&sr=8-63&keywords=linux
http://www.barnesandnoble.com/p/nook-simple-touch-barnes-noble/1102344735
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Running a Linux­based OS, this gray scale Ebook
reader is not only affordable, but also boasts the
longest battery life of all the Ebook readers on the
market: 2 months! It also features a bright­white LCD
display that is easy to see, even in bright sunlight.
Built­in wifi also makes it easy to browse and
purchase books (over 3,000,000) from Barnes &
Noble, and have them delivered to your ebook
reader. Plus, you can also download and read The
PCLinuxOS Magazine’s epub Ebook edition every
month.

OLYMPUS SZ­15 Black 16 MP 24X Optical Zoom
Wide Angle Digital Camera HDTV Output
$149.00

Certainly, there are less expensive point­and­shoot
cameras on the market. But what sets this one apart
is the 24x zoom, that goes from a 25mm wide angle
lens (in 35mm terms) to a 600mm extreme
telephoto. Couple that with the 16 MP resolution and
the excellent reputation of Olympus, and you have a
deal that’s hard to beat. This camera will also take
720p HD video, which can be played back on your
TV, via the camera’s HDMI port.

Pivothead Aurora Shale Video Recording
Eyewear $299.00

Newegg and Pivothead say “You are not a spectator
in life. You are a participant. Don't record your life
through a viewfinder. Live, capture, and share
moments of your life from a truly unique perspective
­ your own.”

* Brilliant HD video 1080p @ 30 fps / 720p @ 60fps /
720p @ 30fps

* Auto, Continuous, Fixed, and Macro Focus
Settings

* 2GB SDRAM, 8GB internal memory capacity

No Windows T­Shirt from CafePress $26.99

Adult sizes Small to 3X­Tall and 11 different colors
including camouflage.

Child sizes 2T to 4T and 4 colors ­ $19.99

2013 Annual Holiday Gift Guide: YouCanToo's Picks

Where *BSD & Linux Converge

http://www.dosgamesarchive.com/
http://forum.fossconvergence.org/index.php
http://www.jupiterbroadcasting.com/tag/linux-action-show/
http://www.newegg.com/Product/Product.aspx?Item=N82E16830111578
http://www.newegg.com/Product/Product.aspx?Item=N82E16886997002
http://www.cafepress.com/mf/33852396/i-have-no-windows_tshirt?productId=381171064
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by Linuzoid as told to Smileeb

Let me introduce Linuzoid

I included a large photo of my avatar, but none of
myself. I've never posted any of myself and never
intend to do so. I believe in anonymity. Hope you'll
understand.

I did it this way because I was having a problem with
Gmail. I'm on dialup and Gmail doesn't like it. It
seems it was made for high speed.

How old are you?
I'm 47 years young.

Are you married, single or what?
I'm single.

Do you have children, grandchildren?
No children

Are you retired or working, for how long and at
what.
I've been a self employed artist for most of my life.

What is the area you live in like? Weather,
Quietness, Scenery.
I live in rural part of New Mexico. Here, we
experience a little of all four seasons. I sit right in the
middle of the Sangre de Cristo mountain range. I'm
surrounded by Juniper and Pinon trees. The
mountain vistas are beautiful here, as are the
sunrise and sunsets. The Pecos River is nearby, so I
fish a lot.

Autumn

Pecos Valley

Pecos Winter

Sangre De Cristo Mountains

Snowtime

PCLinuxOS Family Member Spotlight:
Linuzoid
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Are you handy with your hands or have any
hobbies?
I enjoy oil painting and most forms of art, especially
music, my first love. I like to garden. I also enjoy
fishing, and I'm a life member of the North American
Fishing Club.

What is your education level?
I earned my G.E.D. back in 1993.

Do you like to travel or go camping?
I used to go camping when I was younger, but since
I move out of the city, it's kinda like I'm camping
everyday. I never really travel. I'm a homebody,
really.

What caused you to try Linux and join this
forum?
I started using Linux because I got tired of paying
Microsoft for an operating system full of bugs. I
stopped with Windows ME, and since then, I've only
used Linux. I started with Mandrake, but as soon as
PCLinuxOS came to be, it became my main
operating system. I joined the forum because I want
to help my fellow members as I can. Being a proud
member of PCLinuxOS. Being a contributor to its
excellence is very important and a great honor to
me.

PCLinuxOS Family Member Spotlight is an
exclusive, monthly column by smileeb, featuring
PCLinuxOS forum members. This column will allow
“the rest of us” to get to know our forum family
members better, and will give those featured an
opportunity to share their PCLinuxOS story with the
rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb in the PCLinuxOS forum expressing your
interest.

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark

Czechoslovakia

Italy

Poland

Brazil

Sunrise

Donate To PCLinuxOS
Community Supported.

No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one­time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

PCLinuxOS Family Member Spotlight: Linuzoid

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
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by OldGuy

The November 2013 issue of “The PCLinuxOS
Magazine” had an article about “KeePassX: Not In
The Cloud.”

I had put together a series of text files to help a
friend with running his paid VPN under PCLinuxOS.
We are both using KDE64. Using the Auto­Type
functions of KeePassX, I wanted to make his login
simplified. The old way had several cut/paste
sequences.

He uses iVPN (https://www.ivpn.net/). For my
testing, I choose VPNBOOK
(http://www.vpnbook.com/freevpn). However, the
same setup should relate to both, if not all, VPN
services.

Please note while reading these samples that my
home directory is named /home/alpha, and yours will
be different, so you will have to edit any reference to
your home directory. Also, the password for
VPNBOOK does change periodically, and as of the
writing of this article, it may have changed again. Be
sure to check the VPNBOOK site for the correct user
and password to use their free VPN.

I downloaded the US OpenVPN Certificate Bundle
from the VPNBOOK site, and installed the unzipped
files into a directory called VPNCerts under my
home directory. Use TCP if you cannot connect to
UDP, due to network restrictions. I also downloaded
openvpn from the PCLinuxOS repositories. This
article assumes your firewall is set to no firewall, or
that you have the tun0, tun1, tun2, along with eth0,
checked on the firewall.

VPNBOOK has 4 different certificates; vpnbook­us1­

tcp443.ovpn, vpnbook­us1­tcp80.ovpn, vpnbook­
us1­udp25000.ovpn, vpnbook­us1­udp53.ovpn. You
will need to make a KeePassX entry for each one
you plan to use.

How to setup a KeePass entry, one entry per
certificate

Title: VPN tcp 443 I chose this to reflect the
certificate. You can use any name here.

Username: vpnbook

Guide to proper entries for url for each
certificate. Pick ONE per entry.

Note that my home directory has a dedicated
directory where the certificates are stored, in
/home/alpha/VPNCerts. You will have to edit these
entries below to reflect your home directory.

Url line for each certificate: note that the use of the
semi­colon allows us to do more than one command
on the url field.

cd VPNCerts;openvpn ­­config vpnbook­us1­
tcp443.ovpn

cd VPNCerts;openvpn ­­config vpnbook­us1­
tcp80.ovpn

cd VPNCerts;openvpn ­­config vpnbook­us1­
udp25000.ovpn

cd VPNCerts;openvpn ­­config vpnbook­us1­
udp53.ovpn

Password: ne9UFE9a

Repeat: ne9UFE9a

Note my test root password is
“SuperUserPassword.” Remember to replace it with
your root password.

Comment line:

Auto­Type:
su{ENTER}SuperUserPassword{ENTER}{url}{ENTE
R}{username}{ENTER}{Password}{ENTER}
Auto­Type­Window: alpha : bash – Konsole

My Konsole window shows alpha, see Auto­Type
above. Yours will have another name. Open a
Konsole to see its name (title). For example, if your
login name is mary your window might be:

Auto­Type­Window: mary : bash – Konsole

My research on using Auto­Type comes from
http://KeePass.info/help/base/autotype.html.

Sample of a filled entry in KeePassX.

Quick Guide To Running OpenVPN
With KeePassX

http://keepass.info/help/base/autotype.html
http://www.vpnbook.com/free-openvpn-account/VPNBook.com-OpenVPN-US1.zip
http://www.vpnbook.com/freevpn
https://www.ivpn.net/
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Suggested run instructions.

1. Close other programs. Be sure your CAPS LOCK
is off. It interferes with KeePassX.
2. Open a Konsole.
3. Open KeePassX.
4. Select the KeePassX entry for your VPN. Be sure
it is highlighted.
5. Press CTRL+V, or right click on the entry and
select "Perform Auto Type." KeePassX will close to
the task­bar and type all the vpn commands to
Konsole.

When you see "Initialization Sequence Completed"
displayed in the terminal window, open your browser
and check your ISP to be confident you are on the
VPN. To check, you can go to
http://www.whatismyip.com/. It will show your ISP
location, which should be different from your normal
ISP.

If you do not see "Initialization Sequence
Completed" in Konsole, press CTRL+C, and then
exit. Then, select another certificate to try again. I
found that vpnbook­us1­udp53.ovpn would not work
on my machine, but the other three ran just fine.

If you cannot connect check your firewall settings,
most likely your tun0, tun1, tun2, or tun3 are not
checked. They appear on page three of the firewall
setup. They need to be checked to run the VPN.

When you are completed with your surfing via the
vpn session, follow these next steps.

6. Close browser.
7. In your Konsole session press CTRL+C, now you
can review the Konsole vpn session, or "X" out of
Konsole to close Konsole.
8. Move on to your next task in life. Good luck, and
good surfing.

Example after surfing and pressing CTRL+C, you can
review your session or use “X” in the right hand

corner to exit the Konsole session.

Example directory of certificates.

Example showing Konsole open, and selected 443 in KeePass,
ready for you to press CTRL+V to initiate the vpn session.

Example showing "Initialization Sequence Completed"
we're ready to open our browser and surf on the vpn.

Defending Your Rights

In The Digital World

Quick Guide To Running OpenVPN With KeePassX

http://www.linuxfoundation.org/
https://www.eff.org/
http://www.whatismyip.com/
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by Paul Arnote (parnote)

In last month’s magazine, we detailed the problems
that the PCLinuxOS and The PCLinuxOS Magazine
websites suffered by Avast! antivirus labeling of
those sites as containing malware. I also touched on
why it’s better to run Windows in either VirtualBox or
VMWare, instead of dual booting. So, I thought we
should explore that line of thought a little further.

As I’ve stated previously, I’ve been a Linux user for
the past seven plus years, and a PCLinuxOS user
for six plus years. When I first started using Linux, I
would always set up my computers with a dual boot
configuration, so that – “just in case” – I could
choose to boot up into Linux or Windows XP.

I discovered something along the way. Before long, I
found myself booting into my Windows partition less
and less often. After a while, I was forcing myself to
boot into Windows at least once every three months,
just to apply the requisite updates. But even that
became a very arduous and dreaded task.

Initially, I was afraid of losing access to the programs
that I had become accustomed to using under
Windows. So, when I’d come across a task, my
inclination would be to boot into Windows XP and
perform the work there. Then, I’d have to reboot into
my Linux partition and finish things up. I soon
became aware of just how much time I was wasting
just booting between two different operating
systems.

So, I made an earnest attempt to find Linux
programs to replace the Windows programs that I
had relied upon. Believe it or not, it wasn’t as hard
as I thought it would be. I originally thought that
there was no way that Linux would have anything to

replace Program X or Program Y. But, one by one,
the old Windows programs I had previously relied
upon were replaced with Linux equivalents. Those
Linux program equivalents were, much of the time,
easier and more stable, plus many of them did much
more than the Windows counterpart that they
replaced.

In other cases, I would find two or three Linux
programs to replace the one Windows program that I
had been using. I didn’t originally realize one aspect
of Linux application development: do one thing, and
do it well, unlike many Windows programs that try to
be all things to all users. So, by combining the
capabilities of multiple Linux applications, I was able
to do everything I needed, right there within my
Linux session. No more wasting time rebooting for
me! Hooray!

Sure … there is WINE, but it’s an imperfect solution,
at best. With WINE being steadily improved upon, it
is getting better. However, it will never be a perfect
solution. It will never be able to run all the Windows
programs that users want to be able to run. Hands
down, a virtualized Windows installation will run any
Windows program you throw at it, without any loss of
functionality.

Excuses, excuses

I really think that the real reason users insist on
setting up a dual boot configuration is that they are
afraid of letting go of something that is known, and
learning something new. Human nature is to prefer
to have a crutch to fall back on. Ok, call it a backup
plan, if you prefer; in this case, it’s the same thing.
Most humans also hate change. Humans are
creatures of habit, and they rebel against new
things, even if they are better.

No one in the history of computing or mankind was
ever born knowing how to run any particular
operating system. Every user, in the beginning, had
to learn how to run or operate an operating system
from scratch. Every user had to take the time then to
learn something new, and the same thing applies
even years later when moving to a new platform,
such as Linux.

“I’m a gamer, and I need Windows to play my
games.” This is one of the more prevalent excuses
users have for maintaining a dual boot configuration.
Even as recent as 18 months ago, this would have
been true. However, with the fairly recent release of
Valve’s Steam client for Linux, this is no longer the
case. While I am not a gamer, I have been closely
following the release of the Linux Steam client and
the reverberations it has sent through the gaming
community, as well as the Linux community.

The release of a Linux client for Steam has helped
ignite the rocket engines that are propelling Linux to
the front lines of the gaming industry. In many cases,
game performance under Linux outpaces the
performance of the same game under Windows.
OpenGL is proving to be a much better graphics
rendering system than Microsoft’s DirectX, which

Why A Virtual Windows
Installation Beats Dual Booting
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has historically been the predominate graphics
rendering system used for games over the past 10
or 15 years. Couple this with AMD/ATI, Intel and
nVidia rewriting and/or reworking their Linux
graphics drivers for vastly improved graphics
performance, and it’s the equivalent of adding
booster rockets to the main engine that’s thrusting
Linux into the gaming spotlight.

Every month, more and more games are being
tweaked to run under the Steam Linux client, and
some games are being released only under the
Steam Linux client.

“I have to have Windows to run Program X and
Program Y.” This excuse is used almost as
prevalently as the one used by gamers. For my
personal use, I can’t think of any such programs,
except for income tax software – and that is the fault
of the software vendors, not the lack of a market. In
every other instance, I’ve been able to find Linux
replacements for those Windows programs that I
used to rely upon.

A lifetime ago, when I was a Windows user, my
favorite “go to” graphics program was Paint Shop
Pro. I had been a steadfast user of every version
since Paint Shop Pro 2.0. Under Linux, I’ve found

Gimp to be a much more than capable replacement.
I’ve not been able to find anything that I was
previously doing with Paint Shop Pro that I cannot
do under Gimp. I just had to rethink the process in
Gimp terms, rather than Paint Shop Pro terms. Plus,
I find Gimp capable of doing much more.

So, let’s say that you just absolutely have to be able
to run a specific Windows program. The two
Windows programs most often listed as “can’t live
without” programs for many users are Adobe
Photoshop and one or another of the Quicken
offerings. Some users want to use the extremely
expensive graphics software that they have
purchased when they were Windows users, such as
Adobe Photoshop. For my use, and the use of many
other users, Gimp has matured to be a full featured,
premium quality graphics editor, and is well suited to
replace Adobe Photoshop for most users. I could
never afford to use any of the overpriced Adobe
graphics programs, so I have long been accustomed
to finding other ways to achieve what I wanted and
needed to do.

Others bemoan the lack of any of the Quicken
software offerings, and Quicken has done an
outstanding job of locking users into using their
proprietary system. In the case of these two
programs, and any other you want to throw in there,
a virtual installation of Windows makes much more
sense, quickly and more than adequately providing a
resolution to being able to run those “can’t live
without” Windows­only programs.

Why Virtual Is Better

Like I mentioned earlier, you waste a lot of time
booting between two operating systems. When
running a virtual machine, that “other” operating
system – and all of the programs you run on that
“other” operating system – are available at your
fingertips, only a few mouse clicks away.

Of course, we’re talking of running your virtualized
copy of Windows on a PCLinuxOS host. Doing it the
other way around doesn’t make any sense, given
the extreme vulnerabilities of Windows. Running
Windows on a PCLinuxOS host leaves your
Windows installation isolated from your PCLinuxOS
host, while leveraging and inheriting the infinitely
increased security of PCLinuxOS. How isolated your
Windows installation is from your PCLinuxOS host is
up to you. If you limit the use of “shared folders” on
your PCLinuxOS host – or eliminate their use
altogether – you can limit the exposure of files on
your PCLinuxOS host to threats from Windows­
centric malicious software.

Under a dual boot scenario, you first have to shut
down PCLinuxOS, then boot up your Windows
installation. When you’re finished working in
Windows, you have to then shut it down properly,
then reboot your computer into your PCLinuxOS
installation. This results in a lot of wasted time
waiting for your selected operating system to boot,
shutdown, boot, shutdown, then boot again.

With a virtualized installation of Windows, you only
have to start the virtualization software, then boot
Windows from there – all from right within your
currently running PCLinuxOS session – and you skip
all of the time wasting that’s inherent with a dual
boot installation. If you use VirtualBox’s seamless
mode, you can effortlessly switch between your
running PCLinuxOS applications and your Windows

Why A Virtual Windows Installation Beats Dual Booting
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applications with only a mouse click or two. If you
don’t want to use VirtualBox’s seamless mode, you
can also run Windows full screen on one of your
PCLinuxOS virtual desktops, and your PCLinuxOS
programs on any of your other virtual desktops.

Thanks to VirtualBox’s “shared folders,” you can
share files from your PCLinuxOS installation with
your virtualized installation of Windows. With shared
folders, you can even save your files from your
virtualized Windows installation to your PCLinuxOS
directories. It would be prudent to limit what folders
on your PCLinuxOS system you give your virtualized
Windows installation access to, to limit any potential
damages from Windows vulnerabilities.

The other nice thing about running Windows in
VirtualBox is that you can take “snapshots” of a
working installation. If your working copy of Windows
becomes corrupt or infected with a virus, all you
have to do is use the snapshot copy. Make a
snapshot of your snapshot, and you have a
perpetual “safe” backup. You will literally be back up
and running in a matter of seconds, as opposed to a
full blown re­installation – which can often times take
hours. You can make as many snapshots of your
working Windows installation as you like.

Summary

With a virtualized installation of Windows, you have
the “best of both worlds.” In a sort of having your
cake and eating it too view, you can have the
security and stability of Linux and still use the
Windows programs that you are reluctant to part
ways with.

We have covered running Windows and other
operating systems in VirtualBox several times in the
pages of The PCLinuxOS Magazine. Here is a list to
help you get started:

October 2008: VirtualBox: Easier Than You Think!
January 2009: VirtualBox Tips

May 2012: Move VirtualBox Drives With Ease
November 2012: Fun With VirtualBox Using Terminal
September 2013: Want To Run Windows In
VirtualBox? For FREE?

While the 2008 article may initially seem a bit dated,
the process has remained essentially unchanged in
the five years since it was written. This is regardless
if you are installing Windows XP, Windows Vista,
Windows 7, or any other version.

Even today, I rarely launch or run my virtualized
Windows installation. For me, the only time is when

I have to run income tax software. For the rest of the
year, it pretty much sits there on my hard drive,
untouched.

You may think or heard that running VirtualBox is
difficult, but you can put your fears to rest. As my
2008 article is entitled, it really is easier than you
think. You owe it to yourself to give it a try. I have no
doubts that you will not regret it, and that you will
find yourself moving between your native Linux
installation and your virtualized Windows
installations much more efficiently.

Screenshot ShowcaseScreenshot Showcase

Postecd by OldGuy, November 24, 2013, running KDE.

Why A Virtual Windows Installation Beats Dual Booting
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PCLinuxOS is the one to choose
When you're surfing around the net

It's the only OS that we use
The best we've found yet

Tex and his helpers work day and night
Wrapping up those packages for our delight

Viruses and malware never a threat
Those troubles you'll not get

Give it to your sweetie she will be amazed
Burn it to a new diskette

Install it for your boss and get a raise
Maybe a new Corvette

Fans around the world boot it day and night
'Cause they know it always works just right

Download PCLOS you won't regret
Simply Radical you bet MP3 OGG

PCLinuxOS Is The One To Choose
ms_meme's Nook:

http://pclosmag.com/html/Issues/201312/files/pclinuxosistheonetochoose.mp3
http://pclosmag.com/html/Issues/201312/files/pclinuxosistheonetochoose.ogg
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SUDOKU RULES: There is only one valid solution to each Sudoku
puzzle. The only way the puzzle can be considered solved
correctly is when all 81 boxes contain numbers and the other
Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled for
you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 9 and no
two numbers in the same column of a Sudoku puzzle can be the
same. Each row must contain all of the numbers 1 through 9 and
no two numbers in the same row of a Sudoku puzzle can be the
same.

Each block must contain all of the numbers 1 through 9 and no two
numbers in the same block of a Sudoku puzzle can be the same.

SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non­English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters
in your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to
12 minutes per letter tile set.
7. Have fun! It's only a game! Possible score 262, average score 183.

PCLinuxOS Puzzled Partitions
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1. Island group in the South Pacific

2. African country where the Pyramids are

3. Island in the Mediterranean Sea

4. Next to Sweden

5. “Down Under”

6. Narrow, South American country on the
Pacific Ocean

7. Between Norway and Finland

8. Home of the “Great Wall”

9. Country shaped like a boot

10. North half of North America

11. The Matterhorn is here

12. Largest country in South America

13. Its capital is Moscow

14. Country in northern Africa

15. Largest Central American country

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: December 2013
Countries

Download Puzzle Solutions Here!

http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
http://pclosmag.com/html/Issues/201312/files/2013-12-PuzzleSolutions.pdf
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America
Argentina
Australia
Belgium
Brazil
Britain
Canada
Chile
China
Denmark
Egypt
Finland
France
Germany
Greece
Ireland
Italy
Libya
Mexico
Norway
Peru
Philippines
Poland
Russia
Scotland
Spain
Sweden
Switzerland
Turkey
Vietnam

PCLinuxOS Puzzled Partitions
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by Paul Arnote (parnote)

April 8, 2014. That is when Windows XP SP3
reaches its “end of life.” After that date, Microsoft will
no longer support this aging, albeit still very popular,
version of their operating system. That means there
will be no further updates, security related or
otherwise. And, with Microsoft withdrawing support,
it won’t be long before third party software vendors
follow suit and stop supporting Windows XP SP3.

So … what to do, if you’re a Windows XP user? It
won’t be long before you are locked into a cold, dark
room – so to speak. And, there’s reason to fear the
dark. With no more security updates forthcoming,
every day that you run Windows XP increases the
chance that some rogue hacker will find a way to
exploit its many vulnerabilities.

Sure, a user could upgrade their computer and buy
or install a later version of Windows. But what if you
can’t afford a new computer? What if you can’t afford
upgrades to your current computer? What about
your older, still­quite­capable computer hardware?
Fortunately, there is a solution: install Linux.

Nevermind the naysayers and the negative opinions
espewed by Windows and Microsoft diehards. Linux
is ready for the desktop. Linux is stable. Linux is
secure. Linux is, feature for feature, a viable
Windows alternative. Just ask anyone who has used
Linux exclusively for the past several years – me
included.

Take Time To Find Alternatives

Granted, there are several popular Windows
software titles that aren’t available under Linux, such

as Microsoft Office, Quicken, Adobe Photoshop, and
many others. Rumors surfaced a few months back
about Microsoft “exploring” the release of a Linux
version of MS Office. But, there are also many viable
replacements for those popular Windows­only
programs.

Most users find LibreOffice to fulfill their office suite
needs quite nicely and completely. KMyMoney and
GnuCash have quite a following among Linux users
as a replacement for the Quicken suite of financial
programs. Most of the popular features of
Photoshop are available in the free Gimp graphics
editor.

Many programs Windows users are familiar with are
also available under Linux. Firefox, Thunderbird, and
Chrome immediately come to mind. There are full
Linux versions of each available in almost every
Linux distribution – PCLinuxOS included.

Even popular shareware/freeware programs, such
as the popular graphics viewer IrfanView, have Linux
equivalents. XnViewMP is one such popular
graphics viewer, among at least a dozen others.

However, if you find yourself unable to live without
IrfanView, there is a special version of IrfanView in
the PCLinuxOS repository, that runs in its own WINE
container!

If you find that you just cannot live without a
Windows installation, then be sure to check out the
“Why A Virtual Windows Installation Beats Dual
Booting” article, elsewhere in this issue. You will
enjoy a full­blown Windows installation, right there
within your secure PCLinuxOS desktop. You should
also give WINE a look. Short for WINE Is Not an
Emulator, WINE allows many Windows programs to
run on Linux. WINE is an open source “duplication”
of the Windows API, all done without any
infringement on any Microsoft copyrights or patents.

Make Sure Your Hardware Is Compatible

Actually, this step is far easier than most people
realize. The best way to insure that all of your
hardware is compatible with Linux is to run a Live
CD. That usually gives you a pretty accurate
indication.

NOW May Be The Time To Move To Linux
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Because Linux – and the entire FOSS community –
are often shunned by hardware manufacturers,
Linux usually gets very little “love” when it comes to
device drivers. While the situation has improved
greatly over the past few years, there are still many
instances where the only Linux drivers around are
the ones that are “homegrown.” This is particularly
true where it concerns cutting edge hardware.
However, if you are converting from running
Windows XP SP3 on older hardware, chances are
quite good that drivers exist for all of your hardware
components.

Research your hardware components. Perform an
internet search for Linux drivers specific to your
hardware components. You might be pleasantly
surprised at what you find.

Anticipate A Learning Curve

Many of the skills you developed while using
Windows will transfer directly to Linux. But, at the
same time, don’t expect everything in Linux to work
exactly as it did in Windows. Linux is similar, but
different. Some of the differences will be striking,
while some of the similarities will also be just as
striking.

No one was born knowing how to run Microsoft
Windows. Just as you had to learn Windows, expect
to spend some time learning the ins and outs of
running Linux. Persistence is your friend. The
journey may seem a bit daunting at first, but you will
be surprised at how fast you learn the “Linux way.”

You will not have to go on your Linux journey alone –
unless you just absolutely insist. Make use of the
help forums (PCLinuxOS has one of the best). You
would be well advised to read the sticky posts in the
help forums, and conduct yourself according to the
rules of the forum. Every Linux distribution has a
help forum. Some are just more helpful and friendlier
than others.

Linux: T­H­E Up & Coming Gaming Platform

Since the release of Valve’s Steam client for Linux,
gaming hasn’t been the same. Ever since Gabe
Newell, CEO of Valve, declared “Windows 8 a
catastrophe for game developers,” Valve has thrown
its energies into making Linux the premiere PC
gaming platform.

Once the bastion of Windows, many games have
been rewritten and tweaked for Linux. DirectX is out.
OpenGL is the new standard. As a result, many of
the games run better under Linux than they ever did

under Windows. Since the release of the Linux
Steam client, game developers have released over
200 games for Linux.

Additionally, Steam recently announced the
forthcoming Steambox gaming system. What is
Steambox? Well, it’s a well tuned gaming PC, using
the Linux operating system.

So what about your collection of Windows games?
Granted, not all of them will run under Linux. Game
developers have little incentive to go back and
rewrite old games for Linux. But many of those
Windows games will run under WINE, with a little
help from a WINE helper program called
PlayOnLinux. Install PlayOnLinux from the
PCLinuxOS repository, and take a peek around at
everything that is available. Also, don’t forget about
using a virtual Windows installation, via VirtualBox,
as described elsewhere in this issue.

At the very least, perform an internet search using
“running [name of game] on linux” as your search
term. You will be pleasantly surprised by the results
you come away with. Even if your favorite game
doesn’t net any results, perform the search again in
a month or two. There are many determined and
enterprising individuals working on getting their
favorite games running under Linux.

Summary

I made the switch to Linux about seven years ago.
I’ve spent six of those years (happily) as a
PCLinuxOS user. I switched to Linux after
Microsoft’s previous flop with Vista. I simply couldn’t
afford the upgrades that Vista required, and I was
nowhere near ready to scrap my fairly recent
computers. I certainly couldn’t afford new computers.

I realized that there must be something better “out
there.” I had previously tried Linux back in 1999 with
Red Hat 5.2, which I purchased at Best Buy. Back
then, I tried it out on my 486­DX4 with 32 MB RAM.

NOW May Be The Time To Move To Linux
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While I got it to run, I had absolutely NO idea what I
was doing. I looked at all of those @%$&! RPM files,
and couldn’t figure out what to do with them. I was
lost. I headed back to a Windows world (Windows
98, to be specific) with my tail between my legs,
whipped.

This time around, however, things were different.
Linux had matured WAY beyond what I had first
experienced. It was easier and more intuitive to use.
As with every other user making the transition from
Windows to Linux, I had new things to learn and old
things to relearn.

Persistence and perseverance are your friends in
your journey from Windows to Linux. In the end, the
rewards are enormous.

Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http://twitter.com/iluvpclinuxos

linuxfordummies.org

There Are No Stupid Questions

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by Meemaw, November 1, 2013, running Xfce.

NOW May Be The Time To Move To Linux

http://twitter.com/iluvpclinuxos
http://linuxfordummies.org/
http://www.linuxforum.com
http://www.pclinuxos.com/?page_id=10
http://www.linpc.us
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by Meemaw

Not all the photos we have are in perfect condition,
especially older photos of parents or grandparents.
My cousin and I have shared many photos of family
members, and many of those photos are not in the
greatest shape. Many are torn or cracked. If you can
scan and save these photos to your computer, Gimp
can help you do a good job of fixing them.

I have this photo that is cracked and too dark in
places;

I would like to fix the cracks and even out the color.
Find a photo you would like to fix and we’ll get to it.

Opening it in Gimp, the first thing you should do is
choose File > Save a copy. Name it whatever you

wish and allow it to be saved with the .xcf file
extension. This way you will still have your original
photo just in case something happens to your work.

Fixing the cracks will be done with the Clone
tool, which looks like a date stamper to me.

Click on the Clone tool, choose a place in your photo
you want to fix and, holding down the <CTRL> key,
click on a spot nearby that is the same color and
texture you want to use to fix the crack. If necessary,
zoom into your drawing to see your work more
clearly. Also, depending on what you need to clone,
adjust the size of your brush. I’m working on the
background, which has darker lines every so often,
so I made my brush 5.5 px wide. The circle with the
+ inside is the indication that my clone area has
been selected.

You will want to use small strokes and go slowly.
Also, you will want to change your clone sample as
many times as necessary to match the area you are
fixing. I have to change several times because the
background is a light color with darker lines, and
different areas of the photo are different shades of
those colors.

While I am at it, I’ve decided to try to reconstruct the
bottom right corner of the photo, which has torn off.
For the background, I have chosen to copy an area
of the existing background and place it into the
missing corner. I used the crop tool and outlined an
area, clicking <CTRL> + C (Copy) and then <CTRL>
+ V (Paste), and then moving each pasted piece into
position down the right side of the photo.

The tear on the corner also cut off part of her arm,
so, using the clone tool again, I very slowly put the
same colors as her blouse into the photo, changing
my clone selection where it needed to be lighter or
darker. I can always go back and put in more detail,
but I’m happy with it at the moment. Any time you
are happy with the work you have done up to that
point, you should save your work. Remember, if you
clone in a color and it looks wrong, you can always
use <CTRL> + Z (Undo)

GIMP Tutorial: Fixing A Photo
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Once you get everything cloned to your satisfaction
and save your photo, you can lighten the color a little
by choosing Color > Brightness ­ Contrast. The
Color menu has several color tools, but we can start
here.

You can slide the sliders in the center, or click on the
up & down arrows at the right. I choose the arrows
because the sliders are not as easy for me to control
and I always go too far. The good thing about the
arrows is that you can go up or down one number at
a time, and stop when you think you have it right. I
ended up setting the brightness up to around 72 and

the contrast up to about 22, but your photo may
need different settings. When you get what you think
you want, click OK.

This doesn’t look right yet. One trick you can use is
to Undo your editing using <CTRL> + Z and then
Redo it using <CTRL> + Y. Toggling back & forth will
give you an opportunity to see the original in
comparison to your work, and decide what you need
to do next. I don’t think it’s quite sharp enough, so
I’m going to set the contrast up a bit.

I like this one, so I saved it. Feel free to keep
adjusting your photo until it looks right to you, then
save it.

The next thing I’m going to do is rotate my photo. It
looks like it was placed in the scanner crooked. Click
on the Rotation tool, then click in the center
of the photo. You will get a Rotate window,
and a grid will appear over your photo. Using
the arrow keys will help you rotate your photo until
it’s correct (mine only needed a few degrees). When
you are finished, click OK. You can always open it
again if you decide that you need to change it.

Last, I’m going to crop the ragged edges out of it.
Using the Rectangle Select tool, draw a rectangle
around the photo and the choose Image > Crop to
Selection. When you have it rotated and cropped to
your liking, save your work. You can always keep the
.xcf file to work on it further, but you can also Export
your photo to an image file (png, jpg or whatever you
want). Remember, if you click “Save”, your photo is
saved as a Gimp .xcf file. If you want to save it as
anything else, you should click “Export…”, then
choose the format you want (next page, top left).

One other item is the color of the photo. This photo
has a sepia tone to it. Some of the tone may be
intentional by the original photographer and some
may simply be yellowing because of age. You may
wish to reduce the sepia tone using Colors > Hue­
Saturation. This will change it to more of a black &
white photo. Here is the photo with the saturation
adjusted by ­50 (next page, bottom left).

GIMP Tutorial: Fixing A Photo
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As always, it is your creation, so you can change it
as much or as little as you want. When it looks good
to you, and you think it’s finished, then you should
save it and/or export it.

We’ve seen that just a few tools in Gimp’s toolbox
will help us “restore” a photo, or at least repair one.
I’m sure that your photo album will look wonderful
very soon.

Screenshot ShowcaseScreenshot Showcase

Linux Docs
Linux Man Pages

Posted by alex25502, November 1, 2013, running Mate.

GIMP Tutorial: Fixing A Photo

http://www.die.net/
http://www.linuxforum.com
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by YouCanToo

The tools I use:

Kwrite ­ word processor/text editor
Sigil ­ a multi­platform WYSIWYG ebook editor. It is designed to edit books in

ePub format.
Calibre ­ a complete e­library solution.

As you may know, I took over laying out the HTML version of the PCLinuxOS
Magazine from Rudge. I also create the monthly version of the magazine, in two
popular ebook formats: *.epub and *.mobi.

I start the whole process using the articles supplied by the Editor (parnote) and
Assistant Editor (Meemaw).

I begin by copying the information from the shared documents and paste them
into a set of templates. Then I go about setting up the general format of the page,
IE: paragraphs, syntax, images and music files. When checking the syntax of the
documents, I specifically look for code that can conflict with the HTML layout. I
also change things like smart quotes used in Google Docs to straight quotes
used in HTML. Otherwise, you would see garbage.

Once I have laid out all of the pages as per the PCLinuxOS Magazine article
layout list, I upload that information to the server for review and approval from the
editors. If they happen to spot errors in the layout or omissions of information,
they send me an email telling me about the corrections required. I then make the
corrections and re­upload the changed content to the server, where the editors
once again go through checking everything. This happens until I get things right.
Lucky for me, it doesn’t happen a lot!

Once the HTML format of the magazine has been accepted, I can get to work on
laying out the ebook version of the magazine.

Once again the ebook layout, like its HTML version of the magazine, uses a
template for the basic layout. The content for the ebook comes directly from the
magazine’s HTML edition. Once again, I do this by cutting and pasting just the
basic content into the template. At this point, I am using Kwrite to do most of the
work, and normally have two windows open side by side.

There are some changes that are made to the ebook layout that the HTML
version does not have or need. These occur in the links page. At this point, I have
to convert all <a href=”/201309/files/page01.html”> links to references like <a
href="#page01">, and make sure there is a matching <a name="page01">
statement within the contents.

Creating The ebook Version
Of The PCLinuxOS Magazine
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After copying and pasting all the pages in their proper place, I save the
information and then open the saved file in Sigil.

Once open, I search for the end tag for each page and insert a “split marker.”

This marks the end of each page when you are viewing the ebook in your favorite
reader. Once this is done, I simple save the file as “ebook­template.html.”

Now I open Calibre to finish things up and create the final epub and mobi
versions. I add the book “ebook­template.html” file that I save from sigil. Once
this has been imported into Calibre, I then edit the metadata of the file.

Creating The ebook Version Of The PCLinuxOS Magazine
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We now add the cover image and fill out any missing metadata, along with
selecting the final ebook format.

I then convert the file. We now click “OK” to start the conversion process. This
may take some time depending on the speed of your computer and the size of
the file you are converting.

To make the .mobi format, we will repeat the process, except this time will will
select the .mobi format to use. Now that we have finished converting the
magazine to both the .epub and .mobi formats, the only thing left to do is rename
the files and upload them to the proper place on the PCLinuxOS Magazine web
server for your viewing enjoyment.

Viewing the finished ebook using the Calibre built in ebook viewer (images on
next page):

The PCLinuxOS Magazine

Created with Scribus

Creating The ebook Version Of The PCLinuxOS Magazine

http://www.opensource.org/
http://www.scribus.net
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LinPC.us

Creating The ebook Version Of The PCLinuxOS Magazine

http://www.linpc.us
http://www.linfx.com
http://www.fsf.org
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by daiashi

About The Game

Door Kickers is an innovative real
time strategy game that puts you
in charge of a SWAT team, and
lets you command them during a
tactical intervention.

You analyze the situation, plan
team routes, choose equipment
and breach points and coordinate
multiple troopers to reach the hostage room before
the bad guys get to press that trigger.

It may sound daunting, and like real world CQB
combat, but that’s what it intends to be. Most levels
can be completed in minutes, and on the fly
improvisation works. Achieving the perfect planning,
getting the mission done with no false steps … now
that’s a skill harder to master.

The game is in Alpha phase, which means that we’re
still shaping the basic gameplay but YOU can
already play it. We have a solid blueprint and know
where we’re headed, and each day we add new
features, new tactical options and sandbox
improvements. By contributing with your voice and
money now, you can help shape this game into the
kickass strategy game that you’ll love for years to
come!

Although Door Kickers is currently in alpha, it is
playable but not finished yet. Users and the press
think its already very fun and addictive! And there's a
lot of gameplay in 42 handcrafted levels, plus the
mission generator, as of Alpha 6.

What can you actually expect? Obviously some
features are not yet implemented. There are also
small bugs or gameplay tuning issues and you can
say the experience is not yet final quality. Regular
updates to the game are being released, and will
continue throughout 2013, with an estimated
release of the final game in Q1 2014. Each update
comes with new stuff, new toys, and new levels.

By buying the game in its early access stage, you
will also receive the full game upon its release.

Some additional stuff that will be added to the
final game:

Larger and multi­story locations

More tactical planning options

Melee combat, arrests and surrendering bad guys

Guard Dogs and other enemy types

Oh yeah, also lots of AI improvements

The folks over at KillHouse
Games have just released
version 6 of their tactical shooter
game. It brings with it more guns,
more toys, and more levels.

Being a long time favorite of the
Rainbow Six franchise, this game
certainly has as much to offer, if
not more. True, it’s a top down
shooter: however, it is not turn
based. This means there are no
“you shoot, then they shoot”
scenarios. You can either draw
out a plan similar to a tower

defense game, or just go for it and have direct
control over each member of your team. Choosing
your team from a roster, they can be assigned
different equipment, from handguns to flash bangs.
You have a choice of a breacher class, an assaulter
class, stealth class and a point class as of this
writing. The Breacher class has a choice of shotguns
and handguns, while the assault class has a choice
of assault rifles. The stealth class has silenced
weapons, and the point man only has handguns.

Game play includes eliminating all terrorists,
rescuing hostages and disarming bombs. This is one
of the best tactical shooters I have played in
decades, and I have played most of them. There is
even a spot on their site offering your house and or
face to be used in the game, according to your
donation to the development.

While this is a game, it has some tactical training
exercises that can and are being used
in some local law enforcement agencies.

Along with some graphics that are easy on the eyes,
this game is – wait for it – DRM free. So there are no

Game Zone: Door Kickers

http://inthekillhouse.com/doorkickers/
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hiccups from all that bloated software, as in some
titles. Honestly, if you like strategy games or not, I
think this is a game worth spending some cash on
and giving it a whirl. So tango down and enjoy.

System requirements:

PCLinuxOS and Steam

Hardware:

Minimum:
OS: PCLinuxOS
Processor: Intel Pentium IV 2.6 GHz or equivalent
Memory: 2 GB RAM
Graphics: An OpenGL 2.0 graphics adapter.

NOT SUPPORTED: Intel GMA 9xx / Intel HD
Graphics or older, ATI Radeon X2500 or older.

Hard Drive: 2 GB available space
Additional Notes: 1366x768 minimum display

resolution

Recommended:
OS: PCLinuxOS
Processor: Intel Core 2 Duo

or AMD Athlon 64 X2 5600
Memory: 4 GB RAM
Graphics: NVidia Geforce 9xxx / AMD Radeon HD

/ IntelHD series or better
Hard Drive: 2 GB available space
Additional Notes: A resolution of 1920x1080

About The Company

KillHouse Games is a small Indie studio founded in
late 2012, in Bucharest, Romania. They are
experienced developers and hardcore gamers, not
necessarily in that order. They believe in building
games that matter, games that leave both the player
and the developer fulfilled. They believe in making
games as an engaging experience that enriches

your life, not a boring and mindless passtime that
wastes your time and ruins your health. In the
interest of full disclosure, they admit to being guilty
of losing countless nights to playing games, and will
probably do so till the end of time. Games, like
books, can be THAT good.

Some Gameplay Screenshots

Game Zone: Door Kickers

http://inthekillhouse.com/
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Getting It To Run

Install Steam (if you don’t have it installed
already), then start it. You will need to
create a new account, if you do not already
have one. Once you have Steam up and
running, go to the store tab. Click on the
Linux tab and search for Doorkickers. If
you have updated your system, including
graphics drivers, you should be good to go
(below, left).

Game Zone: Door Kickers

http://pclinuxos.com/?page_id=188
http://www.linfx.com
http://www.opensource.org/
http://www.linuxfoundation.org/
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Top: Posted by ff103, November 5, 2013, running KDE.
Bottom: Posted by jogurtmen, November 3, 2013, running KDE.

Top: Posted by Ika, November 1, 2013, running Xfce.
Bottom: Posted by kensum, November 19, 2013, running KDE.
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